Automated Network Sizin

add-on module for AFT Fathom™ 11
Quick Start Guide | Metric Units

Dynamic solutions for a fluid world ™

AT

Applied Flow Technology

Distribuito da Prode , Milano, Italia www. prode.com



AFT Fathom™ ANS Module
Quick Start Guide

Metric Units

AFT Fathom Version 11
Automated Network Sizing Module

AT

Applied Flow Technology

Dynamic solutions for a fluid world ™



CAUTION!

AFT Fathom is a sophisticated pipe flow analysis program designed for
qualified engineers with experience in pipe flow analysis and should not
be used by untrained individuals. AFT Fathom is intended solely as an
aide for pipe flow analysis engineers and not as a replacement for other
design and analysis methods, including hand calculations and sound
engineering judgment. All data generated by AFT Fathom should be
independently verified with other engineering methods.

AFT Fathom is designed to be used only by persons who possess a level
of knowledge consistent with that obtained in an undergraduate
engineering course in the analysis of pipe system fluid mechanics and is
familiar with standard industry practice in pipe flow analysis.

AFT Fathom is intended to be used only within the boundaries of its
engineering assumptions. The user should consult the AFT Fathom
internal help files for a discussion of all engineering assumptions made
by AFT Fathom.

Information in this document is subject to change without notice. No part of this Quick
Start Guide may be reproduced or transmitted in any form or by any means, electronic or
mechanical, for any purpose, without the express written permission of Applied Flow
Technology.

© 2020 Applied Flow Technology Corporation. All rights reserved.

Printed in the United States of America.

"AFT Fathom", "Applied Flow Technology", “Dynamic solutions for a fluid world”, and
the AFT logo are trademarks of Applied Flow Technology Corporation,

Windows is a registered trademark of Microsoft Corporation.
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CHAPTER 1

Introducing AFT Fathom ANS Module

Welcome to the AFT Fathom™ ANS module, Applied Flow
Technology's powerful pipe and duct system automated sizing tool. With
the ANS module you can automatically size all pipes or ducts in a system
to minimize monetary cost, weight, volume, or surface area. In addition,
you can concurrently size the pumps and pipes to obtain the absolute
lowest cost system that satisfies your design requirements. Finally, by
including non-recurring and recurring costs, you can size pipe and duct
systems to minimize life cycle costs over some specified duration.

How the AFT Fathom ANS module works

The AFT Fathom ANS module consists of three basic elements: the
Graphical Interface, the Hydraulic Solver, and the Automated Sizing
Engine. Figure 1.1 shows the relationship between the three.

Graphical Interface

Input [ Output [*

Hydraulic Solver
4 best size?

9

Automated Sizing
Engine

Figure 1.1  ANS module main component flow chart
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The Hydraulic Solver obtains a balanced hydraulic solution for a specific
pipe or duct system. The Automated Sizing Engine then modifies the
design, and the Hydraulic Solver evaluates the modified design. The
Automated Sizing Engine continues this process until it is satisfied that
no further design improvements are possible. At this point, the
Automated Sizing Engine has converged on a design, and the resulting
sized design is then sent back to the Graphical Interface where it is
displayed to the user.

The Hydraulic Solver, which functions as the prime mover in performing
an engineering analysis (e.g., AFT Fathom ™), becomes a subroutine
called by the Automated Sizing Engine. The Automated Sizing Engine is
the prime mover in the ANS module.

The Automated Sizing Engine employed by the ANS module uses state-
of-the-art numerical searching technology licensed from a leading
developer in this field. This technology has been used for many years in
engineering design, with extensive use in structural finite element
analysis.

Analysis vs. design

Analysis

Traditional piping system engineering has employed pipe flow analysis.
Engineering analysis is the process of using accepted calculation
methods to predict the behavior of a given system. These calculation
methods may be manual, or automated in a computer program.

The weakness of analytical methods for design is that they require the
specification of the system before the methods are applied. Specifically,
the pipe or duct sizes, pumps, valves and other equipment must be
specified in order to perform the calculation.

However, when a new pipe system is being designed, these parameters
are not known. To use the analytical methods, the engineer must guess at
the pipe sizes and required equipment, perform the analysis, then modify
his or her original selections as necessary.

The analytical methods are used iteratively to arrive at a final design.
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Weight, volume

Design

A design-oriented approach to piping system engineering allows the
selection parameters to be variables. Rather than specifying pipe
diameters, the engineer solves for pipe diameters by specifying the flows
and pressures (and other design requirements) and using these to select
the appropriate pipes which minimize the overall system weight, volume
or monetary cost,

Within certain limits engineers do this with traditional analytical
methods. However, the number of design tradeoffs that can be
considered is limited and the tradeoffs considered are indirectly tied to
weight, volume or monetary cost.

The ANS module offers a true design-oriented approach to piping system
engineering by using advanced automated sizing methods to evaluate
competing designs vs. weight, volume or cost, and select the best design.
The analysis method (i.e., the Hydraulic Solver) is called repeatedly by
the ANS module in an effort to identify design improvements (i.e.,
improvements that reduce weight, volume or monetary cost).

and monetary cost are all costs

In the English language we usually associate the word “cost” with
money. However, in engineering that does not have to always be the
case. If an engineer is designing an aircraft, for example, minimizing
weight is essential. In that respect extra weight is a “cost™.

To simplify discussion in this guide, and to avoid needless repetition, the
word “cost” will be used to represent any of the parameters an engineer
may wish to minimize. In the ANS module, this can be weight, volume,
surface area or monetary cost. When discussing issues specifically
related to monetary cost, the words “monetary cost” will be used unless
the context is otherwise clear that the discussion refers to “monetary
cost”.

Cost-based automated sizing vs. cost estimating

The ANS module is not a cost estimating tool. Rather, it offers a rational
and automated approach for comparing potential pipe or duct system
designs using the common denominator of cost. It is the pipe or duct
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system design that the ANS module obtains that is of immense value, not
the process of cost estimating.

AFT Fathom ANS module design capabilities

The AFT Fathom ANS module can be used to size a wide variety of
engineering systems.

Types of systems that can be sized

Piping, ducting and tubing systems
Open and closed (recirculating) systems

Network systems that branch or loop, with no limit on the number of
loops

Pressure fed systems and gravity fed systems
Pumped systems, including multiple pumps in parallel or in series

Pumps with variable speed, controlled pressure, controlled flow and
viscosity corrections

Systems with pressure and/or flow control valves
Systems with valves closed and pumps turned off
Systems with heat transfer and energy balance
Systems with variable density and viscosity

Systems with non-Newtonian fluid behavior

Types of automated sizing parameters available

Pipe size
Pipe velocity, pressure gradient, pressure, flow and temperature

Pump head rise, NPSH margin, proximity to BEP (Best Efficiency
Point), power and others

Control valve pressure drop and open percentage
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ANS module primary window

When the ANS module is activated in AFT Fathom several changes are
made to the interface, though the main impact is the addition of a sixth
Primary Window, the Sizing window. The Sizing window allows for the
sizing and (optionally) cost settings to be configured for the model.
When the model is set to perform sizing, input information in the
Workspace and Model Data windows for the components being sized is
used for initial guesses. Components which are not being sized are
treated as constants for the automated network sizing.

Automated sizing terminology

General automated sizing terminology applied to pipe systems is as
follows:

Design requirements

There are numerous design requirements in the ANS module. Common
requirements are pipe velocity, control valve pressure drop, pump Net
Positive Suction Head (NPSH) margin and proximity to Best Efficiency
Point (BEP).

Active and inactive design requirements

An active Design Requirement is a requirement which has a direct
impact on the solution, whereas an inactive Design Requirement is a
passive requirement which does not impact the solution. If an active
requirement is removed, the ANS module will find a different solution,
whereas removing an inactive requirement will not affect the solution.

Consider a case where several Design Requirements are set for the
velocity in a pipe. One may set the maximum to 5 meters/sec, and the
minimum to 1 meter/sec. If the final pipe velocity were 4.9 meters/sec,
the maximum velocity Design Requirement would be active because the
final value of the velocity is at or near the maximum velocity. On the
other hand, the 4.9 meters/sec pipe velocity is far away from the |
meter/sec minimum. If we remove the minimum velocity Design
Requirement, the result will still be an actual pipe velocity of 4.9
meters/sec. Thus, the minimum velocity Design Requirement is inactive
and does not influence the selected pipe size. On the other hand, if one
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removed the 5 meters/sec maximum velocity Design Requirement, the
actual velocity would probably increase above 5 meters/sec, thus
resulting in a different pipe size.

Objective

This is the goal of the analysis in the system. Typically, the Objective is
to minimize monetary cost either directly using monetary cost data, or
indirectly by minimizing parameters such as pipe weight. As the ANS
module varies the pipe sizes, the objective value (cost, weight, etc.)
varies. The Automated Sizing Engine searches for combinations of pipe
sizes that achieve the objective by comparing these variations.

Continuous vs. discrete sizing

Discrete data is a set of data which lists explicit values that can be used,
such as a set of pipe sizes within a given schedule. Continuous data is a
set of data that includes all values between the given minimum and
maximum, such as percent open values for a valve.

Generally, the desired sizing within the ANS module is discrete, since
commercial pipe sizes must be chosen from a set of specific sizes.
However, since it is much easier to minimize values using a continuous
solution, many methods in the ANS module will first implement
continuous sizing, then use this solution to find a nearby discrete solution
for the system. Note that this is not as simple as just choosing the closest
discrete value around the continuous minimum. Good searching
algorithms like those used in the ANS module will consider values that
are more than one discrete size from the continuous value.

Common size groups

The automated sizing process takes longer as the number of pipes being
independently sized increases. Frequently there are groups of pipes in a
system which would ideally be the same size for design purposes, or
must be the same size by virtue of their location in the system. To link
the sizes for pipes together one can create Common Size Groups. When
one places pipes into a Common Size Group, one is saying that the group
of pipes must all have the same pipe size, and be the same material and
schedule, class, or type. A Common Size Group thus consolidates the
individual pipes that are part of that group to a single pipe size for that

group.
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Feasible and infeasible designs

A feasible design is one which satisfies all Design Requirements, while
an infeasible design does not satisfy one or more Design Requirements.
There are many ways you can create a model that has no feasible
solution. For example, connect a pipe to an Assigned Pressure junction
set to 15 bar. Then place a Design Requirement on the pipe that it cannot
have a pressure greater than 10 bar. Since the pipe is connected to an
Assigned Pressure junction at 15 bar, there is no way for it to satisfy the
10 bar Design Requirement. Thus, no feasible solution exists.

Candidate sets

A Candidate Set is a collection of potential sizes that will be considered
for the sizing calculations. Each pipe being sized in the system must have
one Candidate Set assigned to it. If continuous sizing is being performed,
only the minimum and maximum pipe sizes in the Candidate Set will be
used to bound the continuous sizing.
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CHAPTER 2

Weight Sizing Example

This example shows how to use the ANS module to perform a non-
monetary automated sizing on a system. Parameters such as pipe weight
or volume frequently relate closely to the actual pipe cost and are easier
to set up than monetary cost based automated sizing. This makes them
useful for approximating an initial design. Further, on some systems such
as aircraft, marine vessels or automobiles, minimizing weight may be the
primary goal.

This example demonstrates minimizing the pipe weight in a system.

Topics covered

¢ Non-monetary parameter automated sizing
e Creating Common Size Groups
e Defining Candidate Sets

e Control Valve Design Requirements

Required knowledge

No prior knowledge is required for this example. However, users who
are completely new to AFT Fathom are advised to first complete the
AFT Fathom Quick Start Guide examples. There, one will see how to use
basic features for conventional pipe flow modeling. This example
focuses on the automatic sizing features in the ANS module.
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Model file

This example uses the following file, which is installed in the Examples
folder as part of the AFT Fathom installation:

e Metric - Control Valve - ANS.fth - AFT Fathom model file

e This example is also provided in English units in the “US - Control
Valve — ANS.fth” model file.

This example will require you to build the model from scratch to
familiarize you with the steps required to build a complete model in AFT
Fathom. Therefore, use this example model file as a reference only.

Problem statement

The example is for a fluid transfer system that feeds water from an
elevated reservoir at 12 meters to a lower reservoir at 3 meters. A control
valve is used to control the flow rate at 70 m3/hr and can be placed
anywhere within the line, though it must have a minimum pressure drop
of 82 kPa. For simplicity, we will locate the flow control valve at the
midpoint of the 120 meter pipeline.

The pipeline uses STD Steel - ANSI pipe in the size range from 1-12
inches.

Step 1. Start AFT Fathom

From the Start Menu, choose AFT Products and AFT Fathom.

Activate the ANS module from the Startup Window by checking the box
next to the ANS module. Alternatively, it can be activated from the Add-
on Modules button at the bottom of the Quick Access Panel, or from the
Activate Modules option in the Tools menu.

Once the ANS module has been activated, check that it is enabled for use
by going to Automated Sizing under the Analysis menu and selecting
Network as shown in Figure 2.1. This should be done automatically by
AFT Fathom when the module is activated.
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B3 AFT Fathom - Untitled (Workspace)
File Edit View |Analysis| Tools Database Arange Window Help
ke & By~ AutomatedSizing ’ Not Used - P v b
=y Network
I / Workspace Za Solution Control v - I'E\flsual Report
: 4 System Properties.., kTy s 2
P (e~ - ~ 1 Q-A =2 aa 1k
r Extended Options... -
I oolbox
— P Run Model... Ctri+R
= =

Figure 2.1 Enabling the ANS module for use. The Automated
Sizing menu item becomes available when the ANS
module has been activated.

Step 2. Specify system properties

1. Open the System Properties window by selecting System Properties
in the Analysis menu.

2. On the Fluid Data tab, select the AFT Standard database and then
select “Water at 1 atm” in the Fluids Available in Database list.

Click “Add to Model” to select water for use in this model.

4. Now type in 20 deg. C in the fluid temperature box and click
“Calculate Properties™. This calculates the fluid properties to use in
the model.

5. Click OK.
Step 3. Build the model

A. Place the pipes and junctions

At this point, the first two items are completed on the Checklist. The
Checklist can be accessed by clicking the checkmark icon on the toolbar
or from the View menu and provides a summary of items that must be
completed before the model is run. When the ANS module is activated
the fourth checklist item changes from “Specify Cost Settings™ to
“Define All Sizing Input”.
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For this model the first two items have been completed. The next
Checklist item is “Define All Pipes and Junctions™. In the Workspace

window, assemble the model as shown in Figure 2.2,

/" Workspace
P «

= E
O @
> @
-
?DCI
(L
™
@ &
& oD
-y
o B
& dr

B4

[Base Scenario

#5iing | [AModelDats | [JOutput | [ Graph Results | ® Visual Report |

. - & @ IO a -8 = 9§ 8= | k-

F Qoo o { |

Figure 2.2  Control Valve system layout

B. Enter the junction data

J1 - Reservoir
1. Liquid Surface Elevation = 12 meters

2. Liquid Surface Pressure = 0 barG
3. Pipe Depth = 0 meters

J2 - Control Valve
1. Elevation = 6 meters

2. Valve Type = Flow Control (FCV)
3. Volumetric Flow Rate = 70 m3/hr

i+

-0

oo
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J3 - Reservoir

1. Liquid Surface Elevation = 3 meters
2. Liquid Surface Pressure = 0 barG
3. Pipe Depth = 0 meters

C. Enter the pipe data

For this example, we need to find the best pipe size, but we are limited to
STD pipe sizes. Now we need to use engineering judgment to take an
initial guess at the pipe size for a flow rate of 70 m3/hr. Let’s try 4 inch
pipe. Specify both the pipes as follows:

1. Pipe Material = Steel — ANSI
2. Size =4 inches

3. Type = STD (schedule 40)

4. Length = 60 meters
5

Friction Model = Standard

Step 4. Define sizing input

The first three items have now been completed on the Checklist, leaving
one last item, “Define All Sizing Input”.

In this model we are going to perform sizing to minimize the pipe
weight, while maintaining a minimum pressure drop of 82 kPa across the
control valve. To do this, first go to the Sizing window by clicking on the
Sizing tab, or from the Window menu.

The Sizing window is comprised of multiple panels which can be
accessed using the buttons on the Sizing Navigation Panel along the
bottom of the window, as shown in Figure 2.3. The sizing panels can be
accessed in any order, though it is easiest to enter the information by
navigating the panels from left to right, since the input on panels such as
the Sizing Objective and the Size and Cost Assignments panels will
affect the options available on later panels. Depending on the type of
sizing being done, some panels may be disabled or unused.
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' Workspace | o7 Sizing | [AModel Data | [JOutput | [ Graph Results | ® Visual Report |
& Lock Panel mLock‘PaneLe \E'Unlocknll Panels | §7 Show Status Panel
Sizing Lock Options
£ Lock All Sizing Windows After Run | 2 Sizing Toolbar
Load Default | | Set As Defaul
perfom ~ Chladate N e Mutple Operating Cases
Dos‘:eut [[] Enable Dependent Design Cases | 7
Objectiv e
- Sizing
O window tab
O Pipe and Fluid Weight
(O Flow Volume
() Pipe Inner Surface Area
() Monatary Cost
T =
Sizing
Sizing Level Navigation
Status Box Panel
[v] Desgfbtion and Help
kil p g =
Candidate Design Sizing
Sets Requiremerts

Figure 2.3

Sizing window layout identifying common features

Similar to the Checklist, each panel button contains either a green
checkmark or red circle which denotes the completion status of that
panel. If the minimum required information is present to run the model,
the symbol will be green, whereas the red symbol represents incomplete
input. The amount of information required will vary based on whether
the sizing is set to Perform Sizing, Calculate Weight/Do Not Size, or Do
Not Size. A detailed summary of the items which have been completed
and the items which are still incomplete can be seen in the Status Panel.

The type of sizing calculation being performed, also called the Sizing
Level, can always be seen on the Sizing Level Status Box on the left of
the Sizing Navigation Panel as shown in Figure 2.3. Clicking this box
will bring you to the Sizing Objective panel, where the calculation type
can be changed. The choice of continuous or discrete sizing is selected
on the Sizing Method panel, which is discussed later.
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Note that some panels will always be shown as complete since the model
can be run without any additional information entered on them, such as
the Design Requirements panel. However, in order to find the best
system design, it will often be necessary to enter more than the minimum
information required by the Solver.

The Lock Panel toggle located on the Sizing Toolbar prevents changes to
the current panel when it is enabled. This is primarily useful to prevent
editing once a scenario has been run, since any changes that are made to
a scenario which has output will cause all output to be erased. By default,
all panels will lock after a sizing run is completed, requiring panels to be
unlocked before any changes can be made. This setting can be changed
on the Sizing Objective panel. All panels can be locked or unlocked
simultaneously by using the Lock/Unlock All Panels buttons on the
Sizing Toolbar.

A. Sizing objective

The Sizing Objective panel will be displayed by default when the Sizing
window is first opened, as shown in Figure 2.3. This panel is used to
select the option for calculation and to set the desired Objective.

The first option is "Perform Sizing", which sets up the model to perform
the automated sizing calculation. While it is typically desired to run the
sizing calculations, the other two selections can be useful in certain
cases.

The second option is "Calculate Weight, Do Not Size". This option is
useful to find the cost of the initial design, or for troubleshooting. If the
objective is set to use monetary cost, this option is similar to running
AFT Fathom with the Cost Calculation option turned on.

The last option is "Do Not Size". This is equivalent to performing a
regular AFT Fathom analysis without needing to disable the ANS
module and potentially lose the entered Sizing settings. This can also be
useful to check the feasibility of the initial design before sizing.

Select “Perform Sizing” to begin configuring the sizing run.

The next step is to set a Sizing Objective, which can be monetary cost, or
a non-monetary cost such as pipe weight or flow volume. It is easier to
perform a non-monetary sizing, since all of the geometry and material
information necessary to calculate the pipe weight/volume is already
contained in the pipe material databases. A monetary cost objective
would require cost information to be obtained and entered into cost
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databases. For many systems, sizing the system using one of the simpler
non-monetary objective options provides a sufficient approximation for
minimized cost. In this case, we will be performing a minimization of
pipe weight.

» For the Objective choose "Pipe Weight" and select the Minimize
option from the drop-down list.

B. Sizing assignments

On the Sizing Navigation Panel select the Sizing Assignments button.
The Sizing Assignments panel allows the user to define what will be
sized in the model, and what will be included in the cost calculation
without being sized (in this case, what will be included in the weight, but
will not have its weight minimized). Common Size Groups for pipes can
be created on this panel as well.

In the Sizing Assignments panel the table can be used to select various
options to either “Automatically Size”, or “Do Not Size™ each pipe.

If an “Automatically Size” option is selected, the ANS module will treat
the pipe diameter as a variable and vary it according to certain criteria
that will be discussed shortly.

In a new system, typically all pipes will be desired to be sized and
included in the cost calculation (in this case, the cost is being calculated
in terms of weight). If you are instead analyzing the possible replacement
of existing pipes, it may be better to choose “Include in Weight if Size
Changes™. This will allow the weight to only be calculated for pipes if
they change size, since using the existing pipes will incur no new costs.

[f “Do Not Size” is selected, the pipe will retain the settings currently set
in the Workspace. Why would one choose to not size a pipe? There could
be a number of reasons, but one good reason is that the pipe represents a
pipe in an existing system and the design does not allow the replacement
of that pipe with a new one. Therefore, its diameter is fixed, and sizing
the pipe would be incorrect.

Another reason may be if a certain size is necessary for the design due to
certain requirements, in which case the pipe cost can be included without
sizing the pipe by choosing “Include in Weight”.

This model is a new system, so all pipes will be sized and included in the
cost (weight).

» Select "Always Include in Weight" next to each of the pipes.
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For this system it is required that both pipes be the same size. We will
need to add both pipes to a Common Size Group to specify this as
follows:

1. Click the "New" button above Pipe Grouping, and specify a name
(e.g. “Main Pipes™)

2. A new section will now appear with the “Main Pipes” group listed
under Common Size Groups. Add both pipes to this group by
clicking the corresponding radio buttons (Figure 2.4).

Now that the pipes are both in a Common Size Group, the ANS module
will force them to have the same diameter, rather than allowing them to
be varied separately.

For larger models, multiple Common Size Groups can be created as
desired. Selection tools are available at the bottom of the window to help
assign multiple pipes to a Common Size Group at once. Pipes can only
be assigned to a group once they are set to use one of the “Automatically
Size” options.

Sezing a8 X
W Undo * ~whedo * of LockPanel [ Lock All Panels §&* Unlock Al Panels | 12 Show Status Panel
3 Pipes
Sizing Assignments
Moveto: | oy b ol [ i P H g
Fipes Automatically Size Do Not Size Notin
Hways Include in \Wei Inchude Do Not G
Include in nleight ﬁﬁuw in Weight Include in \Weight o
P1 ® O O ) O
O O

Figure 2.4  Pipes P1 and P2 settings in the Sizing Assignments
panel
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C. Candidate sets
Click on the Candidate Sets button to open the Candidate Sets panel.

To select a specific pipe size, the ANS module needs a list of potential
sizes from which to choose. This list is called a Candidate Set. A specific
pipe can only access one Candidate Set, but a specific Candidate Set can
be accessed by any number of pipes.

So as not to limit the sizing unnecessarily, the Candidate Sets should
include both smaller and larger pipes than your anticipated final size. If
you make the Candidate Set too small, you may limit the ability of the
ANS module to find the best sizing. It is better to make the Candidate Set
too large than too small. Experience in applying the ANS module to
actual systems will help you choose appropriate Candidate Sets. If after
obtaining a solution you find that one or more of the sized pipes is at the
extreme of the Candidate Set, a warning will appear and recommend that
the defined Candidate Set be expanded.

To create a Candidate Set, do the following:

1. Under Define Candidate Sets, click the New button.

2. Give the set a name (e.g., "STD Pipes") and click OK.
3. From the drop-down list choose Steel - ANSI.
4

In the bottom of the Select Pipe Sizes window, check that the Sort
option "Type, Schedule, Class" is selected.

5. Inthe Available Material Sizes and Types on the left, expand the
STD pipe sizes list.

6. Double-click each of the sizes from 1 to 12 inches to add them to the
list on the right, or use the “add” button (Figure 2.5).

7. Inthe Select Pipe Sizes window, click the OK button.
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Select Pipe Sizes
Candidate Set Name: STD Pipes
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Use Thess Sizes and Types in Candidate Sat

- D edube 40)
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2-1/2inch, STD (schedule 40)
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10inch. STD (schedule 40)
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Al | None | Invet  Delete
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Figure 2.5 Select Pipe Sizes window with STD Steel-ANSI pipe
sizes added for 1”-12"

The "STD Pipes" set will now appear. However, we still need to define
which pipes will use this Candidate Set during the automated sizing. By
necessity, a Common Size Group will use one Candidate Set for all pipes
within the group, since all pipes in the group must be the same size, so
there is only one item to assign the set to.

» Under Assign Candidate Sets to Pipes, set the '""Main Pipes"

Common Size Group to use the "STD Pipes" Candidate Set. The
Candidate Sets are now fully defined and assigned to the appropriate
pipes, as can be seen in Figure 2.6.

Once a Candidate Set is assigned, the list of available pipe sizes on the
Pipe Properties window in the Workspace is restricted to pipe sizes in
that Candidate Set. In Figure 2.7 you can see the area normally described
as "Size" is now described as "Size (From Common Size Group)". If the
initial pipe sizes defined in the pipes were not included in the assigned
Candidate Set, the ANS module will change the pipes in the Workspace
to a pipe size from the defined Candidate Set.
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Figure 2.6 Candidate Sets panel fully defined for the model
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Figure 2.7  Pipe Properties Window after having a Candidate Set
assigned to it — pipe size selections are limited to
those in the Common Size Group
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D. Design requirements

Select the Design Requirements button. This panel is used to define
restrictions on the final solution by applying Design Requirements to the
system.

For this model we only have one Design Requirement, which is for the
minimum pressure drop across the Control Valve. To define this
requirement:

1. Select the Control Valves button at the top of the window.

2. Click the New button under Define Control Valve Design
Requirements.

w

Enter a name when prompted (e.g., "Min Pressure Drop").

Next to "Min Pressure Drop" in the table, select Pressure Drop Static
as the Parameter.

5. Choose Minimum for Max/Min, and enter 82 kPa

Now that the Design Requirement is defined, it needs to be assigned to
the appropriate junction.

Check the box next to the Control Valve Junction J2 in the "Assign
Design Requirements to Control Valves" section. The Design
Requirements panel should now appear as shown in Figure 2.8.

|sam. o x
B LockPanel 8 Lock All Panels &8 Unlock All Panels |7 Show Status Panel

@ Pipes | [ Cortrol Vaives. - General luncsons |

[~ Define Control Valve Design Requirements

| _’? ”JJEE_'u H‘- H "‘f ” D-g.]m;muwwmu:hmmhwdnmwdm
[

[ Hame Paramets | Location | Max/Min | Value | Units
1 | Min Pressure Drop Pressure Drop Static |+ | N w | Minsmum v Bk v
|=1 Assign Design Requirements to Control Vahwes
Min Fressure
c.-udwu-l R
J2 =]
E E g showing: 10f 1 Contral Valves (A) Note: The Design Reguirement assignments on this panel an

(] Description and Helo

~
LI

Figure 2.8  Minimum pressure drop requirement defined for the
control valve
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Note: It is strongly recommended that all control valves have a Design
Requirement specified for the minimum pressure drop/head, or the
maximum Cv/percent open at the valve. If no Design Requirements are
applied, the ANS module will allow the control valve to control to any
pressure required to meet the control setpoint, even if this requires the
control valve to add pressure to the system for design purposes. To avoid
this behavior in the final solution, a Design Requirement should be
applied.

E. Assign cost databases

This panel is only used to assign the necessary monetary cost
information when Monetary Cost is chosen as part of the Sizing
Objective. In this case this button is disabled since we are minimizing
pipe weight.

F. Sizing method
Select the Sizing Method button from the Sizing Navigation Panel.

The Sizing Method panel defines the calculation methods to be used for
sizing the system. The User has the option to select whether discrete or
continuous sizing will be used, and which method will be applied.

If Continuous Sizing is selected, the ANS module will use the minimum
and maximum Candidate Set sizes as boundaries. It will then calculate
the ideal hydraulic diameter for the pipes being sized, which will likely
not match any of the possible chosen commercial sizes. While this is not
useful as a final solution, this may be helpful as a baseline to check the
final solution using the provided discrete methods. For this model, make
sure Discrete Sizing is selected.

For the Search Method, the ideal method will often change based on the
number of independent pipe sizes (number of pipes not in group &
Common Size Groups in sizing), number of Design Requirements, and
feasibility of the initial system design. The Help file provides more
information on the strengths and weaknesses of each method. It is
generally recommended to run the sizing with more than one method, as
it is often not obvious which method will be most effective for each
system.

For a simple model such as this one, the MMFD or SQP method should
be appropriate since there is only one Design Requirement, and only one
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pipe size is being varied. Choose the default “Modified Method of
Feasible Directions (MMFD)”.

Step 5. Run the automated sizing

We are now in a position to run the automated sizing. Before doing so,
take a moment to consider what this model is trying to accomplish. The
pipe P1 and P2 sizes will be selected together from the "STD Pipes"
candidate set such that their weight is minimized while still obtaining a
minimum 82 kPa pressure drop across the control valve.

To begin sizing the system select Run from the Analysis menu. While
the model is running, the Solution Progress window shows the "Sizing
Calls to Solver". This is how many times a complete hydraulic analysis
was run.

The Solver also displays the Current Cost and Best Feasible Cost, which
will display the last calculated value for the cost, as well as the Best
Feasible Cost which has been found so far (Figure 2.9). The Solver will
continue to iterate using the defined method to find a global minimum.
For most methods, the Solver will first perform a continuous sizing, then
perform discrete sizing based on the continuous solution, though this is
not always the case.

Note: For complex systems using the Genetic Algorithm Sizing
Method, the solution can be paused and accepted at any time by using
the Pause button, then selecting “Accept Sizing™ under Other Actions.
This allows the user to accept the best current solution, rather than
continuing to search for the global minimum.

When the sizing has completed, click the Output button to display the
results.

Step 6. Review automated sizing results

The Cost Report tab in the General Output section shows a total weight
of 5,099 kg, while each pipe has a weight of 2550 kg (Figure 2.10). This
makes sense since the pipes have equivalent length and a common
diameter due to the fact that they are in a Common Size Group.
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The Sizing tab in the Pipe Output section shows the ideal pipe size was
found to be 8 inch for the pipes when sized together.

The CV Design Requirements tab shows that the 82 kPa minimum
pressure drop is satisfied - the pressure drop for 8 inch pipe was 86.11
kPa. Note that the Design Requirement result is highlighted in blue,
indicating that the Design Requirement was active during the continuous
solution, but the discrete solution was outside of a certain tolerance from
the continuous solution. Yellow highlighting will be used if the Design
Requirement is active in the final solution, and the discrete solution is
within a close tolerance to the continuous solution.

Solution Progress - Discrete Sizing Complete

Masimum Rerations: 50000 [un Teme: H
Relaxation: Automatic

SangMethod  Modfied Method of Feasble Drectons

Sizng Goal Discrete - Objective Costs Include: Pipe Weight

Absolute Tolerance  Relative Tolerance Total Resations.
Max Out of Tol. Max Out of Tol.

Head 1.0E-04 Relative

i Change : [0.000€+00 | [0.000E+00 | [o |
Vol. Flow Rate: 1.0E04 Relative

i m} [0.000+00 | [0.000E+00 | [0 |
Tompoctr [ | | l

Best Feasble Cost  Cument Cost
[s0%9 | 50 | [ |

thnC*Todem%-kﬂl

Actions Pause Cancel Graph Resuilts... Visual Report... Outpat...

Figure 2.9  The Solution Progress window shows the progress of
the AFT Fathom Solver and the ANS module
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Conclusions
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| Total of All Shown Costs
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Items Not In Sizing

Pipe Subtotal

o [P1 Pipe Pipe
Pipe Pipe

A  Pipes| Sizing
Name | Sized- Sized - Sized-Typel | Sized - Hyd
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1 |Pipe Steel-ANSI Binch STD (schedule 40) 7.981
Pipe  Steel - ANSI Binch STD (schedule 40)

Figure 2.10 The Output window shows the hydraulic results of the
sized system, plus the sizing results. The blue color
for the CV Design Requirement indicates this Design
Requirement is “Active”,

This example demonstrates the automated sizing capabilities of the ANS
module for a simple system with a single Design Requirement. Sizing for
non-monetary objectives such as pipe weight is fast and easy to
implement.
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CHAPTER 3

Initial and Life Cycle Cost Sizing

This example demonstrates some key features by using the ANS module
to size a cooling water system for cost.

Topics covered

e How to connect and use existing engineering and cost databases
e Sizing for Initial or Life Cycle Cost and using Initial Cost Limits
e Process to size a pump, and sizing piping for the chosen pump

e Interpreting Cost Reports

Required knowledge

This example assumes that the user has some familiarity with AFT
Fathom and the ANS module such as placing junctions, connecting
pipes, entering pipe and junction properties, and creating and using
Candidate Sets and Design Requirements. Refer to the Weight Sizing
Example in Chapter 2 for more information on these topics.

Model files

This example uses the following files, which are installed in the
Examples folder as part of the AFT Fathom installation:
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e Metric - Sizing Cooling System — ANS.fth - AFT Fathom model file
e Cooling System ANS.dat - component engineering database

e Cooling System ANS.cst - cost database associated with “Cooling
System ANS.dat”

e STD Steel Pipe lin-36in.cst - cost database for STD steel

Problem statement

This example uses an existing model to investigate three automated
sizing cases:

1. Size system for initial cost with a 10-year system life
2. Size system for life cycle cost with a 10-year system life

3. Size system for life cycle cost with an initial cost limit for a 10-year
system life

Step 1. Start AFT Fathom

From the Start Menu, choose AFT Products and AFT Fathom.

Enable the ANS module from the Startup Menu by checking the box next
to the ANS module. Alternatively, the ANS module can be activated
from the Add-on Modules button at the bottom of the Quick Access
Panel, or from the Activate Modules option in the Tools menu.

Step 2. Open model file

For this example, we will be starting from a pre-built model file that is
fully defined for a normal AFT Fathom run. We will add automated
sizing settings to find a more cost-effective design. From either the
startup screen or the File menu, browse to the model file name shown
above and copy it to a new location. The Workspace should appear as
shown in Figure 3.1.
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Sizing systems with pumps

Cooling System example model
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A centrifugal pump can be modeled with either the Pump Curve or as a
fixed flow rate or pressure/head as the Sizing option. Generally if a
specific pump has been identified, the Pump Curve type would be
chosen, whereas the Sizing option is useful during the selection stage in
order to identify the pumping requirements for the system. In some
cases, even though the specific pump has not been chosen, several
candidate pumps are available. For this third case it would be best to

model each candidate pump with a pump curve using separate scenarios
for each pump.

Pump model in this system

The pumps in our cooling water case are both set as Sizing at fixed flows
of 680 m3/hr. In order to allow the pumps to be defined as fixed flows,
the flow control valve at J17 has been defined at a fixed pressure drop of
35 kPa. This model thus represents a first cut model where, based on the
first cut results, the two pumps will become actual pumps with pump
curves, and control valve J17 will become a flow control valve
controlling to 450 m3/hr, similar to control valves J9 and J13.
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As already stated, when a pump is modeled as a fixed flow, it is not a
specific pump from a specific manufacturer. Thus, the costs for the pump
can only be approximated. To a first approximation, it should be possible
to estimate the non-recurring cost (i.e., material and installation cost) for
the pump as a function of power requirements. For instance, a typical one
kilowatt pump (of specific configuration and materials of construction
for a given flowrate) may cost $2500, and a ten kilowatt may cost $5000.
Other typical costs for different power requirements can be
approximated. The actual cost for the pump will, of course, highly
depend on the application. As AFT Fathom evaluates different
combinations of pipe sizes, each combination will require a certain
power from the pump. With a cost assigned to this power, the ANS
module can account for this over the life of the system. Later in this
chapter, we will look at the costs for the pumps in our example cooling
water network.

In addition to non-recurring costs, recurring costs can also be estimated.
Specifically, the cost of the power used by the pump over a period of
time (which the ANS module calls the "system life") can be determined.
All AFT Fathom needs is an overall pump efficiency to determine the
actual power from the ideal power. Again, since we do not have a
specific pump selected yet, the efficiency can only be approximated. The
ANS module calls this the "nominal efficiency”. In addition, users can
provide a "nominal NPSHR".

A step-by-step method of pump selection proceeds in two phases. The
steps are outlined in the Help System.

Step 3. Review model settings

The model is already defined, but we need to review and complete the
sizing settings before running the analysis. In the Analysis menu check
that Automated Sizing is set to Network, then go to the Sizing window
by clicking the tab.

A. Sizing objective
The Sizing Objective panel should be displayed by default.

To begin we will first need to choose the calculation option, so select
“Perform Sizing”.
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As explained previously, a non-monetary parameter such as weight could
be chosen to simplify the sizing. However, there are a few downsides to
this method, as this does not allow one to include pump and other
junction initial costs for the sizing. Additionally, recurring costs cannot
be calculated using non-monetary cost. To more thoroughly size the
pumps in this system we will need to minimize monetary cost directly.

Select Monetary Cost as the Objective and select Minimize from the
drop-down list.

With the Monetary Cost selected, the options to minimize monetary cost
will appear displayed in a table, along with several options to the side
that will activate depending on the cost types being analyzed. Several
common analysis types can be selected in the list box above the table to
automatically configure the table.

From the list box choose “Size for Initial Cost, Show Energy Costs”.
This will set the table to include material and installation costs in the
Sizing Objective and will calculate the energy costs without including
them in the Objective, as can be seen in Figure 3.2. This will allow us to
size for the initial costs and include the energy costs for comparison
when we later size the system for life cycle cost (initial costs and
recurring costs combined).

Since the energy costs are included in the cost calculation, users must
provide a System Life and, optionally, interest and inflation rates to
calculate the present value of the recurring costs.

Enter 10 years for the System Life, with 0% for the interest and
inflation rates.

The source of the energy costs must also be defined. Simple energy costs
can be entered here, or it can be specified that energy costs come from
Energy Cost Databases, which would need to be added on the Assign
Cost Databases panel. An Energy Cost Database allows variable energy
costs to be used to account for varying prices during different times of
day, different seasons, etc.

Choose "Use this Energy Cost Information”, with a cost of 0.11 U.S.
Dollars per kW-hr. Note this assumes the pump will run all day, every
day, for the entire 10 years.

The Sizing Objective panel should now appear as shown in Figure 3.2.
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Figure 3.2 Sizing Objective panel setup for an Initial Cost analysis

B. Size/Cost assignments

On the Sizing Navigation Panel select the Size/Cost Assignments button.
For this example we are sizing both the pipes and pumps for a new
system, so we will need to calculate and minimize cost for all related
components in the model.

» Select the Pipes button and set all pipes to “Always Include in Cost™.
See Figure 3.3.
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Figure 3.3  Size/Cost Assignments panel with all pipes included
in sizing

Note: The selection tools below the Size and Cost Options table and the
Move To buttons above the table can be used to quickly select and assign
large groups of pipes simultaneously.

To decrease the run time and reduce complexity, as well as to enforce
some design uniformity, it is useful to create Common Size Groups to
link the pipes in different sections of the model.

For example, if all the 22 pipes are selected to be “Not In Group”, then
22 unique pipe sizes will be selected by the automatic sizing engine. That
could potentially mean, for example, different suction pipe diameters in
pipes 2 and 5. A similar thing would happen for discharge pipe
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diameters. If one wanted the suction pipes 2 and 5 to be sized to the same
diameter, one would group them into a Common Size Group. To see how
this works, in this model all suction and discharge piping for both pumps
will be put into a Common Size Group. What this means is that there will
be one unique diameter chosen for this group of pipes, rather than
potentially six different diameters.

For this system we will define 5 groups to be sized in this model. To set
the groups, it is normal to select pipes which must have the same size
due to their placement relative to other pipes and junctions, such as pipes
at the entrance and exit of valves. In Figure 3.4 we have identified three
main sections of the model to begin grouping the pipes.

-

P12

i) A (]
Section B P17

Section C

< I >

Figure 3.4 Cooling System model with sections identified to
make groups

First let’s create a “Pressurizer” size group for pipes P1 and P22, which
are outlined as section A. The inlet and outlet lines to the pressurizer
would logically be identical, though they will not necessarily share a size
with other piping in the model.

Click the “New” button above the Pipe Grouping section to create the
group, and name it “Pressurizer”. Select the radio buttons under the
“Pressurizer’” heading next to P1 and P22 to add them to the group.
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Alternatively, the pipes can be selected in the Workspace, then moved to
a group by right-clicking the Workspace and selecting the corresponding
option from the menu,

Now let’s repeat this process for the piping in section B around the
pumps and control valves. Since these units are operating in parallel with
identical flow rates, we would again expect the pipes in this section to
have a common size. Similar to above, create a new group called ‘“‘Pump
Station”, and add pipes P2-P7 outlined in Figure 3.4 to the new group.

Lastly consider section C, the piping near the coolers. In this case we
have three coolers in parallel, with several header pipes connecting the
cooler piping segments. We would expect the piping at the coolers and
control valves to have a common size, but the header piping (P12, P16,
P17, P21) would likely be larger, so we will group them separately.
Create three common size groups as follows:

1. *“Cooler Piping” group with pipes P9-P11, P13-P15, and P18-P20
2. “Clr Headers 1” with pipes P12 and P16
3. “Clr Headers 2" with P17 and P21

The completed Size/Cost Assignments can be seen in Figure 3.5, with
only pipe P8 left not in a group.

Note: The number of Independent Pipe Sizes in the model can be
seen in the bottom right of the Size/Cost Assignments panel, and
denotes the number of pipe sizes being independently varied (i.e. the
number of Common Size Groups, plus the sized pipes not in a group).
This information is useful for choosing Sizing Methods and
troubleshooting purposes.

Click the Pumps button to switch to the Pump Size/Cost Assignments.
Select the option to “Include in Cost Report and Sizing” for both pumps
so that the ANS module will size the pumps along with the pipes as
shown in Figure 3.6.

Similar to the Common Size Groups for pipes, Pumps can be placed into
Maximum Cost Groups based on monetary cost. If pump costs are added
to a Maximum Cost Group, the ANS module will determine the pump in
the group with the maximum costs and set all pumps in the group to the
same costs as that pump. In this case we do not want to group the pumps,
so nothing else needs to be added for the pumps.

We also want to include the Bend junctions in the sizing for this model.



36 AFT Fathom 11 ANS Module Quick Start Guide

» Click the General Junctions button and change each of the Bends (J5,
17,116, J19) to “Include in Cost Report and Sizing” (Figure 3.7). We are
now finished with the Size/Cost Assignments.

Note: Pipes in the Size/Cost Assignments table can be sorted by
Common Size Group instead of sorting by number by clicking on the
"Pipe Grouping" header. Clicking on the header for a particular group
will sort the pipes in that specific group to the top of the window.

Now go to the Workspace window. It is possible to inspect the Common
Size Groups in the model by coloring the pipes. From the View menu,
select All under Color Common Size Groups. The model should appear
as shown in Figure 3.8. It is also possible to color a specific Common
Size Group from the Size/Cost Assignments panel by right-clicking on
the header of the desired group.
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Figure 3.5 Pipe settings in the Size/Cost Assignments panel
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Figure 3.6  Pump settings in the Size/Cost Assignments panel
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Figure 3.7  Junctions tab in the Size/Cost Assignments panel
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Figure 3.8 Common Size Groups shown by color in the

Workspace

C. Candidate sets
Click on the Candidate Sets button to open the Candidate Sets panel.

You should see that the STD Steel 17-36" Candidate Set has already
been created for the model. Expand the set by clicking the “+ sign next
to its name to see that the pipe sizes from 1" to 36" have been added for
STD Steel - ANSI pipe.

In the bottom section of the window, check that each of the Common
Size Groups and pipe P8 have been assigned to use the existing
Candidate Set. The window should appear as shown in Figure 3.9,
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Figure 3.9 Candidate Sets panel fully defined for the model

D. Design requirements
Select the Design Requirements button.

Design Requirements can be applied to both sized and unsized pipes and
junctions. Design Requirements are design limitations on certain
parameters. For example, there may be a Design Requirement that the
velocity cannot exceed 5 meters/sec. As the ANS module evaluates
different pipe sizes, if a particular size results in a velocity greater than 5
meters/sec, that pipe size is rejected because it causes a Design
Requirement violation.

When a pipe that is not sized has a Design Requirement, it means that the
sized pipe sizes cannot be such that it violates the Design Requirement
for the unsized pipe. There can be multiple Design Requirements defined
and applied to a pipe, junction or group. For instance, in addition to a
maximum velocity limit, a maximum pressure limit may exist. Individual
pipes/junctions in a Common Size Group can have different Design
Requirements applied.
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For this model we have multiple requirements for the system:

1. All pipes have a maximum velocity of 3.7 meters/sec

2. All pipes have a minimum static pressure requirement of 100 kPa
3. All heat exchangers must receive a minimum flow of 430 m3/hr
4

All pumps must have an NPSHA at least 3 meters above the NPSHR
(for this system the nominal NPSHR is 15 meters)

5. All control valves must have a minimum pressure drop of 35 kPa

Define and assign the first two requirements listed above as Pipe Design
Requirements as shown in Figure 3.10, and item 4 as a Pump Design
Requirement as shown in Figure 3.11. Notice that we have accounted for
the minimum flow requirement in this system by using flow control
valves at each of the heat exchangers. By using assigned flow pumps and
flow control valves at the heat exchangers we have incorporated the
necessary flow rate as a boundary condition, so we do not need to apply
a Design Requirement to account for this item.
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Figure 3.10 Design Requirements panel for pipes
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For flow control valves J9 and J13 define and apply the minimum
pressure drop requirement in the Control Valves section as shown in
Figure 3.12. Note that for pump sizing purposes as discussed earlier
control valve J17 has been defined as a Constant Pressure Drop valve, so
the pressure drop Design Requirement does not need to be applied to this
valve.
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Figure 3.11 Design Requirements panel for pumps

Sizing o x
& LockPanel 8 Lock Al Panels §5* Unlock Al Panels B Show Status Panel

EF\HI g Puu"m 'Gurml.umr-|

|Elmwmndpm
!

o
| 2 [[ou. [|ceth.

Name |  Parametr | Location | MawMin | Value | Units
1 |DesignDP  Pressure Drop Static [ NiA

|Eiu-n-pmumm

Desgn ¥
Control Valves (> 36kPa)

J8 (FCV #)

13 (FOV#R)

JT7 (FOV#3) O

BB ¥ showng: 30 3Cantrdl vaives (A1) Note: The Design Requinement sssgrments cn

Figure 3.12  Design Requirements panel for control valves
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E. Assign cost databases

Select the Assign Cost Databases button. The material and installation
costs for all pipes and junctions being sized must be entered into cost
databases, which are then assigned to the appropriate components here.
The cost databases needed for this cooling water example have been pre-
built, and just need to be accessed.

The Database Manager (opened from the Database Manager button or
the Database menu) shows all of the available and connected databases.
Databases can either be engineering databases or cost databases. Cost
databases are always associated with an engineering database and are
thus displayed subordinate to an engineering database in the database
lists.

Here we will summarize some key aspects of databases:

e Cost information for a pipe system component is accessed from a
cost database. Cost database items are based on corresponding items
in an engineering database. (The engineering databases also include
engineering information such as pipe diameters, hydraulic loss
factors, etc.)

e To access a cost for a particular pipe or junction in a model, that pipe
or junction must be based on items in an engineering database.
Moreover, that database must be connected to the model, and to the
specific item in the model.

e There can be multiple cost databases associated with and connected
to an engineering database. This makes it easier to manage costs of
items. If multiple cost databases are assigned to a Candidate Set, then
the costs will be stacked to find a cumulative cost.

» Open the Database Manager by clicking the Database Manager button.
The AFT DEFAULT INTERNAL DATABASE, AFT FATHOM
LOCAL USER DATABASE, and PIPE MATERIAL DATABASES
should be available and connected by default. In the top section of the
window, Available Databases will be shown based on databases that
AFT Fathom has identified on your machine. The default connected
databases will be visible here, and additional databases may be visible
from other example files, or from databases previously built and used on
your machine.

This example uses one user-defined engineering database, “Cooling
System ANS.dat”, which contains the data for the pumps and bends.
There are also two cost databases, “Cooling System ANS.cst” and “STD
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Steel Pipe 1in-36in.cst”, which contain the cost data for the junctions and
the pipe materials, respectively. “Cooling System ANS.cst” was built off
of the engineering database “Cooling System ANS.dat”, and “STD Steel
Pipe 1in-36in,cst” was built off of the default PIPE MATERIAL
DATABASE. To connect these databases, do the following:

1. Click the button to "Edit Available List" and select “Add
Engineering Database”.

2. Browse to the AFT Fathom 11 Examples folder (located by
default in CNAFT Products\AFT Fathom | 1'\Examples'), and
open the file titled "Cooling System ANS.dat".

3. Repeat the above steps, but choose “Add Cost Database™ to
browse for “Cooling System ANS.cst”, then “STD Steel Pipe
lin-36in.cst™.

Note that it may be possible that the model file already has the cooling
system databases connected, in which case you will be notified that the
database you are trying to add is already available. If the databases are
available, you will simply need to connect them by selecting them from
the Available Databases list at the top, then clicking the button to "Add
to Connections" for each of the three databases.

Once these steps have been completed, you should now see that the new
databases have been added to the Available Databases list, and have been
automatically connected to the model so that they can also be seen in the
Connected Databases list, as shown in Figure 3.13 for the junction
databases. The junction databases appear in the Connected Databases
section under the names “Cooling System ANS Junctions™ and “Cooling
System ANS Costs”, with the cost database indented beneath the
engineering database to denote that they are linked. The cost database for
the pipes appears with the name "STD Steel Pipe 1"-36", and is similarly
indented under the Steel-ANSI database within the standard pipe
material databases.
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Figure 3.13 Database Manager showing the Junctions for Cooling
System databases connected and available

Once you have confirmed that the necessary databases are connected as
shown, click Close to exit the Database Manager.

Since we are connecting a pre-built database, we will need to take an
additional step to make sure that the junctions in the Workspace are
linked to the Cooling System engineering database that we added.

1. Go to the Workspace, and open Pump#1 (junction J3)

2. From the Database List, select “Pump 680 m3/hr”. None of the input
should change, as this database item is identical to the existing pump.
However, AFT Fathom will now recognize that this junction is
connected to the engineering and cost database for this pump.

3. Repeat step 2 for Pump #2 (junction J6). Similarly, open each of the

Bends (J5,J7,J16,J19 ), and select "Std Elbow" for each from the
Database List.

We have now re-connected the junctions that will be considered for the
Cost Report and sizing calculations to the engineering database. This is
important, since a junction must be connected to an engineering database
before cost information can be assigned to it. Let's now return to the
Sizing window.
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Back in the Assign Cost Databases panel for the Pipes, the “STD Steel
Pipe 17-36" cost database should be the only visible cost database, since
it is the only connected database for the pipe sizes in the Candidate Set.
Make sure that the database is checked to be applied for the model as
shown in Figure 3.14.

Click on the Pumps button, to view the cost database assignments for
the Pumps. The only visible database should be the “Cooling System
ANS Costs” database, as this was the only cost database connected for
the associated engineering database. Make sure that the checkboxes are
selected under the database name so that the cost data will be applied for
each of the pumps (Figure 3.15). To review the cost data for the Bends
click the General Junctions button to verify that the “Cooling System
ANS Costs” is being applied to each of the bends (Figure 3.16).

F. Sizing method
Select the Sizing Method button to go to the corresponding panel.

Select Discrete Sizing to complete the sizing for a set of commercial
pipe sizes.
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Figure 3.14  Assign Cost Databases panel for pipes
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For this model we have 6 independent pipe sizes as noted on the
Size/Cost Assignments panel (5 groups and pipe P8), and 55 design
requirements (2 pipe design requirements applied to all of the pipes, a
minimum flow rate on the 9 Cooler group pipes, and the pump NPSH
requirement). Due to the small number of independent sizes, it would be
recommended to try the MMFD or SQP search method. Though it is not
shown here, if both methods are run for this scenario the same solution
will be obtained, though the Modified Method of Feasible Directions
(MMFD) Method is slightly faster. Select this method from the list as
shown in Figure 3.17.

| Sizing o x)
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Sizing Control Parameters

Search Method:
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Modified Method of Feasible Directions (MMFD)
Sequential Quadratic Programming (SQP)
Sequentia Unconstrained (SU)

Suggest Best Method

Design
Requirements

Figure 3.17 Sizing Method panel defined for Discrete sizing with
the Modified Method of Feasible Directions method

G. Sizing Summary
From the Sizing Navigation Panel select the Sizing Summary button.

The Sizing Summary panel allows the user to view all of the sizing input
for the model in a tree view layout, which is shown in Figure 3.18. Items
can be organized by sizing parameters (Design Requirements, Candidate
Sets, etc.), or information can be viewed for an individual pipe. For
clarity these categories can be shown/hidden using the check boxes at the
top of the panel.
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Each tree node can be expanded/collapsed individually by using the *+’
and ‘- buttons on the node. Alternatively, the buttons on the bottom of
the panel can be used to collapse/expand all items. Right-clicking on the
nodes provides additional options to collapse/expand items, view related
nodes, or to copy information to the clipboard. The Sizing Summary
panel can be printed from the printer button at the bottom of the panel.
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Figure 3.18 Sizing Summary panel layout with the Size/Cost
Assignments expanded. The number of children
nodes for each item can be seen in parentheses.

Step 4. Run the model

Select Run Model in the Analysis menu. This will open the Solution
Progress window. This window allows you to watch as the AFT Fathom
Solver and the ANS module converge on a solution.

After the run has been completed, the results can be reviewed clicking
the Output button at the bottom of the solution control window.
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Step 5. Review the output

Itemized
Pipe Costs

Itemized
Bend Costs

Itemized
Pump Costs

The Cost Report is shown in the General Section of the Output window
as shown in Figure 3.19. (The Output Control has been set up to show
costs in thousands of U.S. Dollars, and to show one decimal.)
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Figure 3.19 The Cost Report in the Output window shows the total

and individual costs (in thousands of U.S. Dollars) for
the sized system
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The ANS module shows all costs in the Cost Report, including those that
were calculated but not used in the automated sizing. The total cost for
this system is $3,258,100. This includes all costs over 10 years, The
initial cost, which was the basis for the automated sizing, was the total of
the material and installation costs ($587,300). This total is listed as the
total for the "Items in Sizing" line, since it was specified to only include
the initial costs (material and installation) in the Sizing Objective section.
Individual items that were included in the automated sizing have their
costs highlighted in green, which can be turned on/off in the Format &
Action tab of the Output Control window.

Other costs that are displayed in the Cost Report are "Items Not in
Sizing". These are items that were set to have their costs calculated but
were not included in the automated sizing. Note that the [tems Not in
Sizing total to $2,670,700. Looking across at the subtotal, one can see
that all of this cost is in energy (i.e., pump power costs). This cost will be
included in the automated sizing later for comparison.

In the Pipes section of the Output window the final pipe sizes from the
automated sizing can be seen, along with the Design Requirements
status. The maximum velocity requirement for the pipes near the coolers
and the minimum NPSH margin for pump J6 were active, as is indicated
by the highlighting (Figure 3.20).

For this model, the final system used pipe sizes varying from 10 to 16
inches, as seen in Figure 3.21. Data on the Common Size Groups and
pipe costs can also be viewed from here. The information for the pumps
can be seen in the Pump Summary tab in the General Section, which is
also shown in Figure 3.21.

When a monetary cost objective is selected, additional tabs are available
that display the Database Sources used for the Cost Report for each of
the pipes/junctions. In this case both the Pipe Material and Pipe
Installation costs for all of the pipes came from the STD Steel Pipe 1"-
36" database which was connected earlier. Information for the Pumps
and Bends came from the “Cooling System ANS Costs™ database. If
multiple cost databases are used for the same cost type they will all be
listed separated by commas. This is useful for model verification.

On the General tab of the Output window at the bottom of the report, the
initial cost of the items included in the sizing can be seen, which was
$649,200 for this design, showing that the initial costs were reduced by
about 10% from the initial design. We can also see that the initial design
was feasible, meaning all of the design requirements were met (Figure

3373
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Though not shown here, if the model is run using the objective to
“Calculate Costs, Do Not Size”, it can be seen that the total cost for the
system before sizing was $3,209,900, which is actually less than the
system that has been sized for initial costs. This is due to the fact that the
larger pipe sizes in the initial system allowed for lower energy costs over
the ten year system life. This system is heavily weighted towards energy
costs, so any change in the energy costs will have a much larger impact
on the overall life cycle cost than the material and installation costs.

Output a x
R LD EB
¥ General
A Pipes | Sizing | Pipe Design Requirements | Database Sources
Velocity Maximum | Pressure Static Overall Minimum
Pipe | <3.7 metersi/sec > 100 kPa
[Max Velocity] [Min Pressure]
7 2123 6942
8 6654
9 657.2
10 5875
1 2399
12 660.5
13 6532
14 5915
15 2440
16 2370
17 2512 660.6
18 648.7
19 611.0
20 2478
271 2512 2438 bt
2 All Junctions | Pump Design Requirements | CV Design Requirements = Database S¢ < *
NPSH Margin Minimum
Jet > 3 meters
INPSH Margin]
3 3.307
6

Figure 3.20 Active Design Requirements shown in the Output
window for the pipes and pumps
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Output o x
= TR S e
A  General Warnings Cost Report | Pump Summary |Valve Summary Heat ExchangerS < *
Results Name Vol. Mass dP dH Dv_adl Speed | Overall
4t Diagram (ma) | (kpioec) | (bor) | (meters) | (Perosnt) | (Percent) | Gaw) |
= Show [...] Pump #1 680.0 1874 5122 5264 70.00 NA 1381
6 E'WEPLIN)#? 680.0 1874 5156 52.99 70.00 NA 1390
Y —— _ -
A Pipes | Sizing | Pipe Design Reguirements Database Sources
Name Sized - Sized - Sized - Type/ Sized - Hyd.
Pipe Matenal Nominal Size Schedule Diameter
(cm)
1 |Pipe Steel-ANS|I 16inch STD (schedule 30) 3873
2 |Pipe Steel - ANS|I 14inch STD (schedule 30) 3365
3 |Pipe Steel-ANS| 14inch STD (schedule 30) 3365
4 |Pipe Steel- ANSI 14inch STD (schedule 30) 3365
5 |Pipe Steel- ANSI 14inch STD (schedule 30) 3365
6 |Pipe Steel- ANSI 14inch STD (schedule 30) 3365
7 |Pipe  Steel-ANSI 14inch STD (schedule 30) 365
8 |Pipe Steel- ANSI 16inch STD (schedule 30) 3873
95 |Pipe Steel - ANSI 10inch STD (schedule 40) 2545
10 |Pipe Steel- ANSI 10inch STD (schedule 40) 2545
11 |Pipe  Steel- ANSI 10inch STD (schedule 40) 2545
12 |Pipe  Steel- ANSI 12inch STD 3048
13 |Pipe  Steel-ANSI 10inch STD (schedule 40) 2545
14 |Pipe Steel- ANS|I 10inch STD (schedule 40) 2545
15 |Pipe  Steel- ANSI 10inch STD (schedule 40) 2545
16 |Pipe  Steel- ANS|I 12inch STD 3048
17 |Pipe Steel-ANSI 10inch STD (schedule 40) 2545
18 |Pipe Steel-ANSI 10inch STD {schedule 40) 2545
19 |Pipe  Steel- ANSI 10inch STD (schedule 40) 2545
20 |Pipe  Steel - ANSI 10inch STD (schedule 40) 2545
21 |Pipe  Steel - ANS|I 10inch STD (schedule 40) 2545
22 |Pipe  Steel-ANSI 16inch STD (schedule 30) 3873

Figure 3.21

Pump and pipe sizes after initial cost sizing is

performed
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Figure 3.22 General section of Output window showing initial
status of Iltems in Sizing

Step 6. Size system for life cycle cost over 10 years

Now we want to size the system based on life cycle costs, rather than just
minimizing the initial costs of the system. As previously discussed, the
energy costs can often be weighted much more heavily than the initial
cost of the system components. This means that sizing based on recurring
costs will often result in larger pipes with higher material/installation

costs being chosen so that smaller pumps with lower energy costs can be
used.

From the Scenario Manager in the Quick Access Panel, we will create
two child scenarios. From the Base Scenario, right click and choose
“Create Child”. Name the new scenario “Initial Cost”. This scenario will
store the initial cost sizing results we just obtained. Repeat this process to
create a second child scenario and name it "Life Cycle Cost". The “Life
Cycle Cost” scenario should now be active, as indicated by the green
check mark symbol. For this scenario the only change that will need to
be made is to update the Sizing Objective.

» Go to the Sizing window, and make sure that the Sizing Objective panel
is selected. Under “Options to Minimize Monetary Cost”, choose “Size
for Initial and Recurring Costs”. This will move the Energy costs
selection to “Include in Sizing Objective™ as shown in Figure 3.23. The
scenario is now complete.
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» Click Run from the Analysis menu to run the automated sizing. When
the calculations have finished, click Output to view the results. The new
Cost Report can be seen in Figure 3.24,

After viewing the Cost Report, it can be seen that the overall cost is now
$3,004,000. The "Items Not in Sizing" line now has a value of zero, and
the Energy column is highlighted green, reflecting the changes made to
include these costs in the Objective.

| Saing o x|
o LockPanel | @ Lock All Panels &8 Unlock All Panels | |2 Show Status Panel

Sizing Lock Options i
[ Lock Al Sizing Windows After Run | ? |
[ﬂ [g] @ | Losd Defat | [ Set As Defaut
P;la:: Calcdate Do Net Size Nuliple Cipersling Cass
. [ Enable Dependert Design Cases |7
Objective
O Pipe Weight
O Pipe and Fud Weight
) Flow Volume
O Pipe Inner Surface Area
(®) Monetary Cost
Minimize: v

Qptions to Minimize Monetary Cost

Size for Iniial Cost sl L
Size for Initial Cost. Show Energy Costs System Life: 110 years -
User Specified SRS Interest Rate !D—] % Per
r years ~
Includein | Cost inflation Rate: |0 *
Cost Type Sizing Report hw““
Only [Energy Cost
Initial Costs (O Use Energy Cost Databases
@ Use This Energy Cost Information
Material O) n
® O Con: US. Dolas 2
Instaliztion ® O Q Per: | kW-r ~
= Oniy this fixed energy cost set here will be used. Al
Recurming Costs Energy Cost settings in the Database Manager wil be
ignored
Energy ® O
[ Initial Cost Limit
Maintenance Q O (O} dax Intial Cos .S, Dollars ~
v

Figure 3.23 Sizing Objective defined for life cycle cost sizing -
Energy cost in table was moved from the “Cost Report
Only” column to the left column “Include in Sizing
Objective”
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Figure 3.24 Cost Report for life cycle cost sizing scenario

Taken on its own, this new cost represents a savings of about $254,000
over the Initial cost scenario which was sized based on Initial Cost only.
This represents an 8% cost reduction. In the initial cost scenario, the non-
recurring cost was $587,300, while the overall cost was $3,258,100. Now
the non-recurring cost is $754,500 while the overall cost is $3,004,000.
The initial cost thus increased by about $170,000 in order to reduce the
operating cost from $2,670,700 to $2,249,500 (a reduction of about
$420,000). The source of the operating cost is the cost of power for the
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pumps. To reduce pump power usage, it makes sense to increase the pipe
size and thus reduce frictional losses. The larger pipe sizes can be
reviewed by looking at the Sizing tab in the Pipe Output section. From
the Pump Summary tab it can be seen that the pump power usage
decreased from 138 kW to 117 kW at each of the pumps, which is
approximately a 15% power requirement decrease at each pump.

Step 7. Apply initial cost limit

While the energy cost savings from life cycle cost sizing are desirable,
the budget for the project may not support the higher initial cost that is
required. In that case, we can apply an initial cost limit to the life cycle
cost sizing.

Return to the Sizing Objective panel and select the option for Initial
Cost Limit. We will set the limit as $649,200, which was the initial cost
before sizing the system. Run the model and go to the Output tab. The
Cost Report can be seen in Figure 3.25.

A summary of the difference between each of the initial and life cycle
cost sizing scenarios for a 10 year life cycle can be seen in Table 3.1.
Notice that while the material and installation costs were limited to the
cost of the original design, the energy costs over a 10 year lifetime are
decreased by about $140,000 compared to the original design. These
energy costs were achieved by increasing the pressurizer pipes, pipe P8,
and several of the header pipes at the coolers while decreasing the pipe
sizes at the coolers. Figure 3.26 shows a comparison of the pipe and
pump sizes throughout the system for the initial design, the system sized
for initial cost only, and the system sized for life cycle cost with an initial
cost limit.

Table 3.1 Cost summary of automated sizing runs for Cooling
System
Sized for: Material | Installation | Total non- | Energy Overall Reduction
recurring Total

Not sized (original design) 404,900 244300 649,2000 2,560,800 3,209,900

Sized for initial cost 363,400 223,900 587,300| 2,670,700 3,258,100 -49,000
Sized for life cycle cost 487,600 266,900 754,5001 2,249,500 3,004,000 205,900
Sized for life cycle cost with 409,900 238,400 648,300[ 2,421,800 3,070,100 139,900
initial cost limit
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Figure 3.25 Cost Report for life cycle cost sizing scenario with
initial cost limit

Discussion on sizing with pump curve data

One can consider the previous discussion in this chapter as Phase 1 of the
pump and pipe sizing process. Phase 2 involves using the Phase 1 results
in order to select actual pumps which have pump curve data. The actual
pump should closely match the sizing results in the generated head at the
design flow, efficiency at the design flow, and cost. If it does not, then it
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Conclusions

may be advisable to repeat the Phase 1 sizing with updated information
from actual pumps (e.g., monetary costs, nominal efficiency, nominal
NPSHr, etc.). A complete Phase 2 analysis will run the automated sizing
again for each actual pump considered. The pipe sizing may change
slightly for each pump considered.

By reviewing the Pump Summary for the life cycle cost sizing with an
initial cost limit, one can see that the ideal system calls for a pump of
about 126 kW that generates about 48 meters of head at 680 m3/hr. The
nominal efficiency used in the sizing part of the analysis was 70%. The
material cost for such a pump was about $28.,400, and the installation
cost was about $9,500. Note that if no actual pumps can be found that
reflect these requirements, then the Phase 1 process should be repeated
with better performance and/or cost data for the pump.

Using cost databases in the automated sizing process involves increased
complexity from simple non-monetary automated sizing as discussed in
Chapter 2. However, it allows more powerful automated sizing options
including the ability to size costs over a system life cycle.
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Figure 3.26 Pipe and pump sizes selected by the ANS module for
initial cost and life cycle cost sizing with initial cost
limit



CHAPTER 4

Multiple Design Case Example

This example will size the pipes for a water supply system to a housing
development where there are two design cases. This example uses
monetary cost automated sizing.

Topics covered

This example will cover the following topics:

* How dependent design cases are used to satisfy two different
operating modes for a system

e Common Size Groups and their effect on how well the ANS module
can size a system

Required knowledge

This example assumes that the user has some familiarity with AFT
Fathom ANS module such as placing junctions, connecting pipes,
entering pipe and junction properties, and creating and using Candidate
Sets and Design Requirements. Refer to the Weight Sizing Example in
Chapter 2 for more information on these topics.

Model files

Metric - Housing Water Supply - ANS.fih - AFT Fathom model file
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Pipe-PVC-sch40.cst - Pipe cost database for PVC pipe

Problem statement

This example uses an existing model to investigate a single system with
two operating cases. The cases are as follows:

1. Normal flow to houses and North Hydrant closed. Supply to each
house must be at least 2.2 m3/hr with a minimum static pressure of
410 kPa (g).

2. North Hydrant open with at least 23.5 m3/hr and at least 620 kPa
(g) minimum static pressure. During fires the supply to each house
must be at least 0.5 m3/hr with no minimum pressure requirement.

For this example, we will evaluate both operating cases assuming the
pipes can be at most three different sizes.

Step 1. Start AFT Fathom

From the Start Menu, choose AFT Products and AFT Fathom.

Enable the ANS module from the Startup Menu by checking the box next
to the ANS module. Alternatively, the ANS module can be activated
from the Add-on Modules button at the bottom of the Quick Access
Panel, or from the Activate Modules option in the Tools menu.

Step 2. Open model file

For this example we will be starting from a pre-built model file that is
fully defined for a normal AFT Fathom run. We will add automated
sizing settings to find a more cost effective design. From either the
startup screen or the File menu, browse to the model file name shown
above and copy it to a new location. Open the “One Hydrant” scenario
from the Scenario Manager in the Quick Access Panel.

This example consists of a reservoir (i.e., West Lake) at an elevation of
72 meters that supplies water to 10 houses and one fire hydrant. All of
the pipes in the system are Schedule 40 PVC pipe. The supply line to
each house is set to 1 inch PVC. T The automated sizing of this system
will only be used to size the supply line from the reservoir, the
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neighborhood mains, and the hydrant line. The model should appear as
shown in Figure 4.1.
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Figure 4.1  Single Hydrant scenario for Housing Project example

Step 3. Review model settings

A. Sizing objective

Go to the Sizing window by selecting the tab. The Sizing Objective panel
should be selected by default from the buttons along the bottom.

For this analysis, we are interested in sizing the system considering the
monetary cost for the initial costs only.

1. Set the calculation to Perform Sizing.

2. For the Objective, choose "Monetary Cost", and select the Minimize
option from the drop-down list.

3. Under Options to Minimize Monetary Cost, choose "Size for Initial
Cost", which will automatically configure the table to include all
non-recurring costs in the sizing while ignoring the recurring costs.



62 AFT Fathom 11 ANS Module Quick Start Guide

B. Size/Cost assignments
On the Sizing Navigation Panel select the Size/Cost Assignments button.

For the supply lines to each house (pipes 40-54), the pipe size is fixed to
one inch and will not be sized. We will ignore the costs of these pipes for
the purpose of this example, though they could be considered using the
“Do Not Size, Include in Cost™ option.

We want to find the three pipe sizes that will serve for the supply from
the reservoir, the "neighborhood mains", and the hydrant (pipe 1, pipes
10-25, and pipe 80 respectively). To do this, we have to establish one
Common Size Group for the neighborhood mains, while leaving pipes P1
and P80 to be sized separately.

In the Size/Cost Assignments panel select the rows for pipes P1, P10-
P25, and P80 (multiple rows can be selected using the shift or ctrl key).
We will first need to set the pipes to be included in the sizing calculation.

> Move the selected pipes by clicking the “Always Include in Cost”
button above the Sizing and Cost Options table. Now we will need to
create a Common Size Group for the neighborhood mains.

» Click New above the Pipe Grouping table and name the group
“Mains”. Select pipes P10-P25 and use the “Move To” button above the
Pipe Grouping table to add them to the Common Size Group. The
Size/Cost Assignments panel should now appear as shown in Figure 4.2.

C. Candidate sets
Click on the Candidate Sets button to display the Candidate Sets panel.

In this case we will be considering schedule 40 PVC pipe within the
range of 1" - 10".

1. Select New, and name the Candidate set "PVC sch 40".
2. Choose PVC - ASTM from the material list.

3. Expand the schedule 40 type, then double click each of the sizes
from 1 inch to 10 inch to add them to the Candidate Set.

4. Click OK to accept the defined set.

In the bottom section of the window make sure that the Common Size
Group and pipes P1 and P80 are assigned to use the new PVC sch 40
Candidate Set as shown in Figure 4.3.
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Figure 4.2  Size/Cost Assignments panel for the primary design
case

D. Design requirements
Select the Design Requirements button.

For the primary design case the only design requirement is for the
minimum supply pressure of 410 kPa(g) to each of the houses. With the
Pipes button selected click new to add a “House Supply” Design
Requirement specifying the static pressure at the outlet of the pipe to a
minimum value of 410 kPa(g).
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Figure 4.3 Candidate Sets panel for the primary design case

In the bottom section of the window, make sure that the 410 kPa(g)
design requirement is applied to each of the supply lines to the houses, as
shown in Figure 4.4.

Create a second Design Requirement named “Fire Supply” specifying
the static pressure at the outlet of the pipe to a minimum value of 620
kPa(g). We will apply this requirement later when the dependent design
case is created.

E. Assign cost databases

Select the Assign Cost Databases button. The actual material and
installation costs are contained in cost databases.

» Open the Database Manager by clicking the Database Manager button
to see which databases are connected.
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for the primary case

This example uses a pre-built cost database for the pipes containing the
PVC material costs. To connect the database do the following:

1.

2

Click the button to "Edit Available List" and select Add Cost
Database.

Browse to the Fathom 11 Examples folder (located by default in
C:\AFT Products\AFT Fathom 11\Examples\), and open the file
titled "pipe-pvc-sch40.cst".

The new database should now be visible in the Available Databases list
and be automatically connected to the model, as shown in Figure 4.5.

Once you have confirmed that the database is connected, click Close to
exit the Database Manager.

Back in the Assign Cost Databases panel for the Pipes the pipe-pve-
sch40.cst database should be the only available cost database, and should
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be selected to show that it is being applied to the Candidate Set and each
of the supply lines to the houses.
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Figure 4.5 Database Manager showing the PVC schedule 40 cost
database connected and available in the model

F. Sizing method
Select the Sizing Method button to go to the Sizing Method panel.

Ensure that Discrete Sizing is selected with the Modified Method of
Feasible Directions (MMFD) chosen for the Search Method.

G. Dependent design cases

Now that we have defined the primary design case model shown in
Figure 4.1, we will create one dependent design case. A dependent
design case (or DDC) in the ANS module is a system that models the
same physical pipes and junctions as the primary design but with
different operating requirements. The dependent design case for this
model is when the North Fire Hydrant is opened. When the hydrant is
opened, the flow out of the hydrant is 23.5 m3/hr and the homes are
allowed to drop to 0.5 m3/hr each.
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Here are the steps to create this Dependent Design Case:

1. Go to the Sizing Objective panel and select the "Enable Dependent
Design Cases" option. A new button will now be available for the
Dependent Design Cases panel in the Sizing Navigation Panel as
shown in Figure 4.6.

Figure 4.6  Sizing Navigation Panel with Dependent Design Cases
enabled

2. Select the Dependent Design Cases button. You should now see
instructions displayed to create the Dependent Design Case, along
with a summary table of dependent design settings. We will need to
use the Duplicate Special tool to create the dependent design case.

Go to the Workspace and choose Select All from the Edit menu.

4. Open Duplicate Special from the Edit menu, enter an increment of
100 and select "Make Dependent Design Case", and "Clear Design
Requirements" (Figure 4.7). Click OK.

5. Move the duplicated pipes and junctions to distinguish them from the
original ones from the Primary Design Case (Figure 4.8).

Duplicate Special

[ Increment Al Pipe and Junction Numbers By:
[[] Create Group

[] Hide in Output

7] Make Dependent Design Case

[] Clear Design Requirements

jw"‘ 0K !m Cancel 2P Hep

Figure 4.7  Duplicate Special is the easiet way to create a
dependent design case
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6. Open the J180 hydrant to flow in the DDC by selecting it and
toggling off the Special Condition setting on the toolbar.

7. Use Global Junction Edit (from the Edit menu) to change all of the
assigned flow junctions at the DDC homes (junctions 140-154) from
2.2 m3/hr to 0.5 m3/hr (see Figure 4.9).

8. In the Sizing window navigate to the Design Requirements panel.

Assign the "Fire Supply" Design Requirement created earlier to pipe
P180 by checking the adjacent box.

B x
P ~-2-% LA O - e-Al= el 8RNk "0 ¥

T oclibacn.

=2

<

Figure 4.8  Workspace with Primary Design Case (at top) and one
Dependent Design Case (at bottom)
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Global Junction Edit
Choose Data From: Cick “Select Assigned Flow Data...'to Speciy Parameters D o
@ Junction Template | Assigned Fow | Select Assigned Flow Data... ]
O Exising Junction v
Al | None | invet
Junction List- | Workspace | Specil... Parameters to Change (Select in List): Al MNone || Invert
(140  Browns =[] General Data
04 Peters
[]42  Chambers
(143 Fords
(J44  Kelys
[]50  Morths
[151  Stewarts
[]52  Coles -
[]53 Allens [J Replace With |v | Show on \Workspace Number
[]154 Bums O Design Factor 1
(180  Morth Hydrant [ Replace with || Initial Pressure/HGL  Unspecified
% 1:': g‘::: O Junction Icon Apply Selected Junction Icon
[ 142 Chambers O Junction Size Default
% 143 Fords O Special Condition  None
44 Kol O Loss Factor 0
(A 150 Morths .
151  Stewarts =[] DesignAlers
[ 152 Coles ] Replace With || Design Alerts (none)
= LI
(1180 North Hydeart [ Replace With |+ | Notes No Notes
[&| B3| setected: 100 22 El=0
=3 Apply Selections o OK E3 Cancel P Hep
Figure 4.9  Global Junction Edit is used to change the flows to

0.5 m3/hr in the homes for the fire flow DDC

Return to the Dependent Design Cases panel.

When Duplicate Special was performed with Dependent Design Case
selected, each of the duplicated pipes was created with a special type of
grouping. For example, pipe 101 is grouped with pipe 1 as a DDC pipe
(see Figure 4.10). This type of assignment allows the dependent design
pipes to be sized, but to not be counted in the cost so that the cost will
not be duplicated.

It should also be noted that the dependent design grouping causes each of
the dependent pipes to inherit their Common Size Groups, Candidate
Sets, and Cost Database settings from the pipes in the primary case. The
dependent design case pipes are therefore hidden on all sizing panels
except for the Design Requirements and Dependent Design Cases panels.
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Sizing

[ Ppes = General dunciions |

& LockPanel @ Lock All Panels & Unlock All Panels | [IT] Show Status Panel

Dependent Design Cases

Note that Szing Option, Common Size Group, M.

The grid below shows the relations of Dependent anCalu (DDCld:!ﬂ!Hoﬂ'.bm objects, aluslnﬂ'—duw
imum Cost Group, C Set, and Cost

Databases, Modifiers wil whmdbmhau

objects and their Dependent Design Case objects. This grid is informational only. To change parameters, go to the necessary Sizing Panel.

Pipes

-~

DDC Pipe? | Assigned Design Requirements

P1 (Supply Line from Reservoir)

NO

P101 (Supply Line from Reservoir)

YES (P1)

P10 (Neighborhood Main)

NO

P110 (Nesghborhood Main)

YES (P10)

P11 (Neighborhood Main)

NO

P111 (Neighborhood Main)

YES (P11)

P12 (Meinhbharhoned Maind

F13 5T 8|51

NO

Figure 410 Pipes in Dependent Design Cases have a special
grouping relationship with pipes in the primary case

Run the automated sizing

Select Run from the Analysis menu to perform the automated sizing.

After the run finishes, examine the final pipe sizes calculated by the ANS
module. One can see that the resultant size is 3-inch PVC for the
neighborhood mains, with larger 4-inch PVC-ASTM pipe for the
reservoir and hydrant lines, as shown in Figure 4.11,

The cost for all sized pipes is $55,890 (see Cost Report in Figure 4.12).
This is the cost for "Items in Objective". Since we did not size the pipes
to the homes (because these were fixed at 1- inch), they were set to not

be included in the cost report using Output Control.
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Output o x
Bz 29 BB
¥ General
A Pipes | Sizing | Pipe Design Requirements | Database Sources .
Name Sized - Sized - Sized - Type/ | Sized - Hyd. [} A
Fipe Material Nominal Size | Schedule Diameter
| {inches)
: 1 | Supply Line from Reservoir PVC - ASTM 4inch schedule 40 4026
| 10 |Neighborhood Main PVC-ASTM  3inch schedule 40 3.068
| 11| Neighborhood Main PVC-ASTM  3inch schedule 40 3.068
; 12 |Neighborhood Main PVC-ASTM  3inch schedule 40 3.068
i 13 |Neighborhood Main PVC-ASTM  3inch schedule 40 3.068
|_14_|Neighborhood Main PVC - ASTM  3inch schedule 40 3.068
| 15 |Neighborhood Main PVC - ASTM  3inch schedule 40 3.068
i 20 | Neighborhood Main PVC - ASTM  3inch schedule 40 3.068
| 21 |Neighborhood Main PVC - ASTM  3inch schedule 40 3.068
|_22_|Neighborhood Main PVC - ASTM  3inch schedule 40 3.068
| 23 |Neighborhood Main PVC-ASTM  3inch schedule 40 3.068
; 24 | Neighborhood Main PVC - ASTM  3inch schedule 40 3.068
| 25 |Neighborhood Main PVC - ASTM  3inch schedule 40 3.068
| B0 [Line to North Hydrant PVC-ASTM 4inch schedule 40 40268 .,

Figure 411 Results for sized pipes for the case with three
Independent Pipe Sizes

Review the results

The automated sizing we just ran had two operating cases. One was for
normal water supply, and the second was for hydrant supply for a fire.
The normal flow case is modeled by the network shown in the upper part
of Figure 4.8. The second model shown at the bottom of Figure 4.8
models the fire flow case.

The pipes and junctions in the fire flow case are separate entities for
modeling purposes, but represent the same pipes and junctions as the
normal flow case. Thus when performing automated sizing, we only
count the cost of the pipes and junctions once. This occurs in the primary
design case, which in our model is the normal flow case. This is why
pipes P100-P180 are not shown in the Cost Report.
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Output a x
= YR R —
&  General \Warnings CM!W;MMr&mm
e o Name Material | Installation "“&"Eﬁ;‘““ Maintenance Oﬁ“w"i;"’ g’g‘{“g TOTAL

TOTAL OF ALL MO DEL COSTS
| Total of All Shown Costs 18,705 ras 55,890 (1] 1] 0 55890

ltems In Sizing 18705 3718 55,850 o [ 0 55.8%0

Items Not In Sizing 0 0 0 0 0 0 0
| Pipe Subtotal 18,705 37.18 55,890 ] 0 0_55.890|
o P Pipe  Supply Line from Reservor |IDBS3200 16280 25,172 0 0 0 25172
o P10 Fige  Neighborhood Main R 2406 1529 0 0 0 359
o [P Fipe Neighborhood Msin . 748 1608 2352 0 0 0 23152
Lo |Pi2 Fips  Neighborhood Main 748 1504 2382 0 0 0 238
o|P13 Pipe  Neighborhood Main 48 1em4 2382 0 [ 0 23
o P14 Fige Neighborhood Main TR 16 2382 0 0 0 233
o |Pis Pipe Neighborhood Main 748 15pe 238 0 0 0 2319
o |P20 Pipe Neighborhood Main o2 2406 3529 0 0 0 3529
o |F21 Pipe  Neighborhood Main TR 15K 23R 0 0 0 23
o2 Fipe  Neighborhood Main 748 1604 2382 0 0 0 23
o|P22 Fipe  Neighborhood Main 748 1804 2382 0 0 0 238
o |P24 Fige  HNeighborhood Main a8 1504 2382 0 0 0 2382
o|F25 Pipe Neighborhood Main 748 1604 23 0 0 0 23
o |Pso Pipe Line o North Hydrant 8o 137 0 0 0 137

Figure 412 Cost Report is shown in Output window

By applying different pressure and flow requirements between the
normal and fire flow cases, we performed an automated sizing that
selected the best pipe size which simultaneously met the requirements of
both cases.

Finally, since the previous case only selected three pipe sizes to be used
for all sized pipes, there were only three design variables, By creating
more Common Size Groups, a better solution is possible.

Other possibilities

To obtain the best possible design for the system, one can allow each
pipe to be sized independently by removing all pipes from the common
size group. While not shown here, it is possible to reduce the overall cost
for this system to $49,000.

This final automated sizing takes much longer to run (a few minutes vs. a
few seconds previously). Since all the pipes are sized independently, the
practical result is that ordering and installing the pipe is more
complicated because there are so many more sizes involved.
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Alternatively, this sizing could be performed by using weight as the
objective instead of monetary cost to simplify the setup. Using a non-
monetary objective can produce less accurate sizing results in cases
where the energy costs or costs of equipment such as pumps need to be
accounted for. However, since this is a gravity-fed system only the pipe
sizes need to be considered for the sizing calculations. Though not shown
here, changing the objective to pipe weight produces nearly identical
results, with only the line to the hydrant having a slightly larger size.
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CHAPTER 5§

Other AFT Fathom ANS Module
Capabilities

This Quick Start Guide necessarily omitted coverage of a number of
ANS module capabilities. This chapter briefly describes some of the
important capabilities not covered.

Size with operating costs spread over multiple cases

For systems with multiple design cases, the system may operate a
significant portion of the time in each design case mode. The ANS
module allows one to assign a percentage of the operating cost to each
relevant design.

For example, assume you are designing a two-pump cooling system
which uses both pumps in the summer but only one in the winter
(because of reduced demand for cooling water). The winter operating
cost is thus much less than in the summer. You can account for this by
assigning the percentage of the time the pump operates in each design
case. This allows a proper accounting of annual operating costs, and a
proper life cycle automated sizing to be performed.

Vary recurring costs over time
Through "scale tables" the ANS module allows you to input recurring

data for pipes or junctions that vary over time. For instance, perhaps the
maintenance cost of a piece of equipment is low at first but requires
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increased maintenance over some time period. The cost for maintenance
can be varied over time to match the anticipated maintenance schedule.

Time value of money

An important consideration in evaluating recurring cost items is the cost
of money for future expenses. The ANS module allows you to enter an
interest rate and inflation rate to account for actual value of future
expenses based on today's currency value. This data is entered on the
Assign Cost Databases panel of the Sizing window.

Determine cost effectiveness of replacing existing pipe

The ANS module can determine the cost effectiveness of leaving existing
pipe in place or replacing it with new pipe. This can be defined on the
Size/Cost Assignments panel.

Working with different currencies

Cost data can be entered in any currency you wish. Different currencies
can be defined in the Parameter and Unit Preferences window, and then
used as a basis for cost databases.

Costs vs. size

Scale tables can be used to model how equipment costs vary with pipe
diameter. For instance, a 4-inch valve will cost more than a comparable
2-inch valve. This can be accounted for in the cost database by use of
scale tables.

Generic pump costs can be modeled as a function of power, and generic
control valve costs can be modeled as a function of maximum Cv.

Sizing rectangular duct systems

The ANS module can size systems with only rectangular ducts or a
combination of rectangular and cylindrical ducts. Rectangular ducts have
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two space dimensions, and thus two design variables are required for
cach independent duct size.

Compare VFD vs. FCV sized systems

Variable Frequency Drive (VFD) control methods are frequently
compared to Flow Control Valve (FCV) methods. However, this is
typically only evaluated in the context of a given pipe system. The ANS
module allows one to size the system for each of these methods. This
allows a more meaningful comparison.

Maximum cost groups

Discrete costs

When evaluating multiple operating cases, one of the pump operating
modes will drive the pump selection for all cases. This is by virtue of the
fact that the cost will be based on the mode requiring the most power
and/or largest head. This can be modeled in the ANS module with
Maximum Cost Groups. A Maximum Cost Group allows one to couple
costs together for all pumps that will eventually be of the same design
(and thus cost the same). This allows the proper cost information to be
used for each design case.

Maximum cost groups can also be used for control valves.

For sizing items such as pump motors, a discrete cost table can be
created. This allows costs to be reported based on the discrete motor
sizes available for the pump, rather than interpolating the cost assuming
that motors are available for purchase at any capacity.

Network databases

Engineering and cost databases can be located on local PC's or deployed
across local or wide area networks. The Database Manager allows users
to connect to relevant databases for their specific pipe system design.
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Additional AFT Fathom Modules

Goal Seek & Control
GSC Identifies input parameters that yield desired

output values and simulates control functions

Extended Time Simulation
XTS Models dynamic system behavior and how

critical system parameters vary over time

Settling Slurries
SSL Models the effects of pumping fluids containing

settling solids using the Wilson/GIW method
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